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About The Razor

The Razor utilizes a "Whole Wealth" approach to financial planning that includes proven planning
strategies and T1 based tax calculations. The Razor helps deliver financial advice that not only addresses
all of your client's needs, but advice they will also understand.

In addition to using a whole wealth approach, The Razor automates the analysis of your client's financial
needs by answering their most important retirement planning questions:

e "When will | be able to retire?"

e "How much can | spend?"

e "How much do | have to save?"

o "What rate of return do | need to earn?"

The Razor also addresses your client's risk management needs by calculating the optimal amount of
coverage for:

o Life Insurance

o Disability Insurance

o Critical llness Insurance

e Long Term Care Insurance

In addition to this user manual, we also offer the following:

e Sample Reports

e Online Tutorials

e The Razor Glossary
e Training & Support
e Testimonials

« FAQs

Navigation

Navigation throughout The Razor software is done using the View menu of the Ribbon. Select one
of the 5 available buttons to navigate to that area of the software; Wizard, Data, Chart, Ledger or
Report.



The Razor Ribbon Controls

NoRH& a2eEE B ae

Mew Open Save  Print Wizard Data Chart Ledger Report || Calculate Exit About
= Report

File View Misc

The Razor Ribbon is divided into 3 main areas; File, View and Miscellaneous. Over 90% of
Navigation and File Management takes place from the Ribbon.

File Menu

EJH@

Open Save  Print
x Report
File
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. Click the ‘New Client’ button to start a new client file.
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o The ‘Open’ button allows you to open a previously saved client file.
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Click ‘Save’ to save the currently open client file.
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‘Print Report’ will print all selected documents from the Client Report (Financial Opportunity

print |Analysis).
Report

View Menu
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Wizard Data Chart Ledger Report

View
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e The ‘Wizard’ button will take you to the Data Entry Wizard.
1Zar




The ‘Data’ button will take you to the regular Data Entry Screen.

The ‘Chart’ button will take you to the Financial Planning Analysis screen.

The ‘Ledger’ button will take you to the razor Ledger Page.

The ‘Report’ button will take you to the Client Report (Financial Opportunity Analysis).

Miscellaneous Menu
= =

Calculate Exit About

Misc

Click ‘Calculate’ to update the financial analysis after entering or changing client data.

To exit The Razor, click the ‘Exit’ button.

The ‘About’ button will take you The Razor About screen and Resource Center.

File Management

File Management is controlled through the 4 buttons in the File menu of the Ribbon; New, Open,
Save and Print Report.

Starting a New Client File

There are two ways to start a new client file; by selecting ‘New’ from the Ribbon or by clicking
‘Start a New Planning Analysis’ from the About screen. Once selected, the software will prompt



you to save the existing client file. If this is not necessary or you have just loaded the software,
click ‘No’.

Once the new file has been loaded, you are able to begin entering client data by using the Wizard
or Data screens.

If you choose to start a new client file by selecting ‘New’ from the Ribbon, the software will
automatically take you to the Data screen.

If you choose to open the client file by clicking ‘Start a New Planning Analysis’ from the About
screen, the software will automatically take you to the Data Entry Wizard.

Opening a Saved Client File

The Razor operates using a flat file system and not a database. This allows you to open client files
from any location connected to your computer, whether you are using your hard drive, flash drive
or server. The Razor however, is unable to function as a server install and must be installed on
your computer’s “C” drive.

There are two ways to open an existing client file; by selecting ‘Open’ from the Ribbon or by
clicking ‘Open an Existing Planning Analysis’ from the About screen. Once selected, the software
will prompt you to save the existing client file. If this is not necessary or you have just loaded the
software, click ‘No’.

If you choose to open the client file by selecting ‘Open’ from the Ribbon, the software will
automatically take you to the Chart screen (Financial Planning Analysis).

If you choose to open the client file by clicking ‘Open an Existing Planning Analysis’ from the About
screen, the software will automatically take you to the Data Entry Wizard.

Saving an Open Client File

To save your client file, click ‘Save’ in the File menu of the Ribbon. This will automatically save the
client file with the same name and in the same location. If you are saving a new client file the
software will prompt you to select a name and location to save the file.

To save an open file to a new location or with a new name, click the drop-down menu under the
Save button and select ‘Save As’. The software will then prompt you to specify a new name and/or
location for the client file.



Printing

The Financial Opportunity Analysis report is the only area of The Razor that is designed to print.
All reports will print landscape and have predetermined margins. Changing these settings may
provide undesired results.

To print the Financial Opportunity Analysis report, select ‘Print Report’ from the File menu of the
Ribbon. ‘Print Report’ will print all selected documents from the Financial Opportunity Analysis
report; any unchecked document on the Navigation pane will not be printed.

It is possible to print any other area of the software. To print these documents, navigate to the
desired location and hold ‘Ctrl+P’ on your keyboard. This method however, cannot guarantee that
the page layout and print margins are ideal.

Data Entry

There are three ways to enter or change data within The Razor; Wizard, Data or Chart. These 3
areas are all accessible through the View menu of the Ribbon.

The Wizard will guide you through the data entry process and provide a description of the data
entry required.

The Data screen contains all data entry points and planning notes within the software.

The Chart screen (Financial Planning Analysis) allows an advisor to adjust, alter or solve client data
while simultaneously viewing the results. This allows you to see how changes in the client’s
situation will affect all aspects of the analysis.

Client Questionnaires

There are two Client Questionnaires available; Short Form Questionnaire and Long Form
Questionnaire. Both are useable with The Razor and can be accessed through the ‘Open Planning
Questionnaire’ button on the About screen. Neither questionnaire can be imported into the
software.

Short Form Questionnaire
This questionnaire is a very quick and summarized client questionnaire. It has been built to
resemble the Data Entry Wizard and only includes data that is required by The Razor.



Long Form Questionnaire
This questionnaire is a very detailed Know Your Client questionnaire. It is more time consuming to
complete but will provide you with much more detailed client data.

Plan Assumptions

There are two new assumptions included in The Razor that were designed to better analyze a
clients situation while at the same time minimizing the data entry required; Tax Efficiency and
Human Capital.

Tax Efficiency

“Tax Efficiency” is a concept that is applied to non-registered investments and represents the
portion of investment income that is taxable. This concept is easily demonstrated when applied to
the 3 main types of investment income.

» Interest Income which is fully taxable when earned is 0% tax efficient.

o -Capital Gains which are 50% taxable when realized are a minimum of 50% tax efficient.

o -Dividends earned personally are approximately 30% tax efficient depending upon the
province.

There are 2 stages of Tax Efficiency to account for; Accumulation (now till retirement) and
Retirement (from retirement on).

Human Capital

“Human Capital” is a concept that represents the present value of your earning potential. This
concept is used in the Risk Management Analysis report to estimate the amount of insurance
benefits the client needs for life, critical illness, disability and long term care. The assumptions for
Human Capital ask you to specify the timeline and percentage of income to take into
consideration.

Using The Razor

The Razor is separated into 6 main areas; About, Wizard, Data, Chart, Ledger and Report. All of
these areas are accessible through the Ribbon at the top of the screen.

The About Screen

The About screen is the main screen of The Razor. You can access it at any time by selecting About
from the Ribbon. From here you can Open or Start a new planning analysis, download a Client



Questionnaire or access the Resource Center.

MHERAZOR

The Resource Center

This area of the About screen is regularly updated with useful links, such as Online Tutorials, The
Razor Glossary and Sample Reports. Access any of these areas by clicking directly on their icons.

Resource Center

ﬁBE ™ | Getting Started Tutorial
|\

!'EE The Razor Glossary
| 4

HE Sample Reports
|




Data Entry Wizard
The Data Entry Wizard is a client friendly data entry process composed of 6 Steps, covering 24

guestions. Each question focuses on an individual aspect of client data and includes a quick
description of the required data.

Y - crazon

i a |
Confidential Clent Questionmakre e
b . -

Navigation

To navigate through the Data Entry Wizard, use the ‘Next’ and ‘Back’ buttons located on the left
hand side of the Wizard screen. The buttons will take you through each of the 6 steps and 24
qguestions. To jump to a specific planning step, select it from the left hand side of the Wizard
screen. Navigate between the questions of a step by selecting any of the tabs across the top of
the Wizard screen. These tabs will change depending on the step you are currently viewing.
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Getting Started Client | Contact Goals

Step 1:
Personal Information

Step 2:
Sources of Income

Step 3:
Personal Assets

Step 4
Corporate Assets

Step 5:
Plan Assumptions

Step 6:
Prepare Analysis

[Back] x|

Entering Data

Data Fields - To enter client data, type directly into any highlighted field. To avoid possible
‘#Value’ errors, be sure the data entered reflects the format of the cell. Entering text into a
numeric cell can cause ‘#Value’ errors in the calculations.

Date Fields - To enter dates it is suggested you use the same format established in your system
settings, for example “dd/mm/yy” or “mm/dd/yy”. You can also choose to enter dates as “mmm
dd, yyyy” and allow your computer to automatically determine the correct format, for example
Jan 01, 2011.

Age Fields - Some age fields allow you to enter either a numeric value for the age of the client or a
predetermined value from a drop down. Entering text that is not included in the dropdown may
cause ‘#Value’ errors.

Single Clients - The Razor is defaulted to build an analysis for a pair of clients each time you start a
new client file. To build an analysis for a single client, simply delete the spouse’s name and date of
birth. The software will then alter all reports to include only one client.

Preparing the Analysis - The first 5 steps of the Wizard will guide you through entering all client
data and specifying Plan Assumptions. Step 6 finishes the process by preparing the financial
analysis and automatically taking you to the Reports screen. From here you can review the
Financial Opportunity Analysis and select which documents to print.

11



The Data Entry Screen

The Data screen contains all data entry points and planning notes within the software compressed
into one screen. This allows for quicker data entry and data adjustments. The Data screen does
not include descriptions of required data but does allow you to enter planning notes.

Entering Data

Data Fields - To enter client data, type directly into any highlighted field. To avoid possible
‘#Value’ errors, be sure the data entered reflects the format of the cell. Entering text into a
numeric cell can cause ‘#Value’ errors in the calculations.

Note Fields - The note fields included in the Data screen do not require a specific format as the
software will not use this information within the calculations.

Date Fields - To enter dates it is suggested you use the same format established in your system
settings, for example “dd/mm/yy” or “mm/dd/yy”. You can also choose to enter dates as “mmm
dd, yyyy” and allow your computer to automatically determine the correct format, for example
Jan 01, 2011.

Age Fields - Some age fields allow you to enter either a numeric value for the age of the client or a
predetermined value from a drop down. Entering text that is not included in the dropdown may
cause ‘#Value’ errors.

Single Clients - The Razor is defaulted to build an analysis for a pair of clients each time you start a
new client file. To build an analysis for a single client, simply delete the spouse’s name and date of

birth. The software will then alter all reports to include only one client.

Printing - Currently there is no built in print function for the Data screen. To print these
documents hold ‘Ctrl+P’ on your keyboard. This method however, cannot guarantee that the page
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layout and print margins are ideal. We will be looking to add a printing ability to the Data screen
in a future release.

The Chart Screen (Financial Planning Analysis)

The Chart screen allows an advisor to adjust, alter or solve client data while simultaneously

viewing the results. This allows you to see how changes in the client’s situation will affect all
aspects of the analysis.

iigamn

m Tﬂﬂﬂmllﬂﬂﬂﬂﬂlum

Changing Values

Values are organized down the left hand side of the screen. They are organized into 4 main
sections; Investment Savings, Retirement Income, Index Assumptions and Tax Efficiency
Assumption. Each of the 4 main sections contains multiple data entry points. When any data entry

point is selected, the toggle buttons on the right will control the values of that selection. From
here you can increase or decrease the amount, age or years to display.

THERAZOR

Invesiment Savings

Moty RSP Deperal: Chert B

Renial Invseswnant Depos: Chant s [E] ]| & A& | A
Aenual Invvesiment Depos; Chent B - E -

Bevaal [rvetment Depost: Jord

Ratirement Income

£ I]I]El Bl &
Monthly Lifestyle: Pasmoe

Masithly Erpkayrranl: Chint & sl a
Monthly Employment: Chent B E = =
Lifeshyle Line of Credd N
Index A::umiiuns

= |2 E0%
Rl; [reeiment
RO Rl Estate -
Rl Business Oparytons =
Lifestyle Dbt Funding il

Tax EfﬂclancE -\mmE:Inm
|:| l]l]“?i:-

Mon-regsterad: Retrement
Inecoree Sphbngs Fefrement
- | =
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Any values changed will automatically be updated throughout both the Wizard and Data screens.

Be sure to Calculate after altering any values in the Chart screen.

Financial Planning Analysis Charts

There are three Financial Planning Analysis charts; Cash Flow, Income Tax and Financial Assets.
You can zoom in on any of the three charts at any time by simply clicking on the desired chart,
however you can only zoom in on one chart at a time.

Financial Flanning Analysis

Retirement Planning Options

The Retirement Planning Options pane is a list of solved planning options. These options will act as

a guideline when changing and solving values.

Retirement Flanming Options

Crption #1, Adjust Income Geals
Current income gaoal:
Attainable mcome goal:

Orption #2, Adjust Fetirmment Age
Current retiremant age:
Attainable ratirement age:

Option #3, Adjust Rate of Retum
Currend investment ROR
Required imestmant ROR

Orptian 74, Adjust Savings
Current annual savings:
Required annual savings:

350,000
353,900

&0
61

5.00%
5.24%

$19.000
321,000

Solving

You can choose to solve any Investment Savings or Retirement Income values by clicking the solve

button. Select which data entry point you would like to solve and click the solve button. The
software will then calculate the optimal value required for the client to fund retirement.
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Investment Savings

osit: Client A - |$5m;| | G0 | 10
Monthly RRSP Deposit: Client B L
Annual Investment Depasit: Client A -':| [ - - ][ - ]
Annual Investment Deposit: ClientB [ - Z - ][ - ]
Annual Investment Depaosit: Joint 7

Retirement Income

Manthly Lifestyle: Active - |$5,E|E|E| | 60 | 5
Manthly Lifestyle: Passive
Monthly Employment: Client A [ o o ][ . ]
Manthly Employment: Client B [ - Z - ][ - ]
Lifestyle Line of Credit s

Printing
The Chart screen was not designed as a printable report. You can choose to print these
documents manually by holding ‘Ctrl+P’ on your keyboard. This method however, cannot

guarantee that the page layout and print margins are ideal.

The Ledger Page

The Ledger page is a collection of data from every year of the analysis. This section is not designed
to be client friendly as it contains a large amount of data. Use the Ledger page when looking for
more detailed information or to verify where a value originates.

Navigation

Navigation throughout the Ledger is done using the vertical and horizontal scroll bars in The Razor
window. For organizational purposes, the Ledger has been separated into 4 levels of headings;
Main Heading, Sub Heading, Category Heading and Colum Heading. In addition to the 4 headings,
the ledger page also highlights 3 key years; Retirement, Client A Life Expectancy and Client B Life

Expectancy.
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Main Heading

Sub Heading

Category Heading

Calumn
Heading

Fetirement
Client A Life Expectancy
Client B Life Expectancy

Printing

The Ledger pages were not designed as printable reports due to their size and complexity. You can
choose to print these documents manually by holding ‘Ctrl+P” on your keyboard. This method
however, cannot guarantee that the page layout and print margins are ideal.

The Report (Financial Opportunity Analysis)

The Financial Opportunity Analysis report is the completed financial analysis. It consists of 9
report documents and 7 ledger documents. All documents are available for printing through the
‘Print” button on the File menu of the Ribbon.

o—
R
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Navigation

To navigate through the Financial Opportunity Analysis reports, use the ‘Next” and ‘Previous’
buttons at the top of the Navigation pane. These buttons will cycle through any selected reports.
You can also choose to jump directly to a report by selecting it from the list.

16
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Navigation

Select pages fo display and print
W

Cowver Page

Contents

Financial Planning Process
Flanning Assumptions
Financial Summary
Integrated Analysis
Retirement Analysis

Risk Management Analysis

Alternative Investment Strategy

BT ¥ A B3 -3 B 1 (|

Projected Net Worth

Projected Cash Flow

Projected Taxation: Bill

Projected Taxation: Mary
Projected Retirement Investments
Projected Cash Investments

Projected Corporate Investments

Adding or Removing Documents

Any document listed in the Navigation pane can be added or removed at any time by checking or

un-checking the document. When printing, only checked documents will print.

Alternative Investment Strategy
The Alternative Investment Strategy document can display any one of 11 alternative investment
strategies. These strategies do not incorporate client data, but rather open the discussion as to

the benefits provided.

| =

Alternative Investment Strategy

%

= % =

o%E %

Projected Net Worth

Projected Cath Flow

Projected Taxation: Bill

Projected Taxation: Mary
Projected Retirement Investments
Projected Cash Investments

Projected Corporate Investments

Salect strategy to display

JIRP {Cash Value) E] ¥ Owerride Strategy

The strategy chosen is mathematically determined by the software as an appropriate solution for
a client’s situation. At any time, if you do not feel that the strategy selected is not appropriate for
your client, you can override the selection through the ‘Select strategy to display’ dropdown. This

17



dropdown will display all available strategies within the software. By selecting a strategy, the
Alternative Investment Strategy document will be modified. You can choose to reverse this action
at any time by un-checking ‘Override Strategy’.

Salact strategy to display

J]RF‘ {Carsh Valae) Ei W Qwerride Strategy

Franoal Secunty Account

[FP [Reverss Mortgage)
lakse

Estate Bond

ARIF Eslabe Prabacior
Azsal Exlabe Profecior
Inared Anmuty

108 Premium Raducsr

S/7 Fremium Reducer
Corporate Estate Bond
Corporate Capital Tranafer

Printing the Financial Opportunity Analysis Reports

This is the only area of The Razor that is designed to print. To print the Financial Opportunity
Analysis report, chick off all reports on the Navigation pane that you would like to print, any
unchecked document will not be printed. All selected reports will print landscape with
predetermined margins. Changing these settings may provide undesired results. Once your
selections are made, click Print on the Ribbon.
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